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IREM® FINANCIAL ANALYSIS SPREADSHEET GUIDE

OVERVIEW

The IREM® Financial Analysis Spreadsheet is a comprehensive tool that allows the user to
perform several key analyses to gauge the performance of real estate investments. The
spreadsheet includes before- and after-tax cash flow analyses for measuring financial
performance over time, comparison grid analyses for setting average adjusted effective rents,
an HP10BII financial calculator emulator, and tools for calculating effective rent, assessing
leverage position, forecasting budgets, and conducting a discounted cash flow analysis.

Technical Requirements

= To ensure proper functionality of the IREM® Financial Analysis Spreadsheet, your computer
must have Microsoft® Office Excel 2003, Microsoft® Office Excel 2007, or Microsoft® Office
Excel 2010.

* For Mac users, please ensure that you have the full version of Microsoft® Office Excel, not a
free or trial version, as they potentially will not support the full functionality of the tool. In
addition, Mac OS 8 does not support visual basic macros—thus, the clear buttons and
financial calculator tab will not function in the Mac environment.

= Full functionality may be effected by: current version of the operating system, configurations
placed on the computer by the system administrator, conflicts with antivirus or system
monitoring applications, and physical memory size of the computer

Saving a Working Version

Always begin using the spreadsheet by saving a working version from the master file so that
original formulas are not lost. Return to the master version of the spreadsheet each time you
use the tool. To save a working version of the file, follow the steps below.

Microsoft® Office Microsoft® Office Microsoft® Office
Excel 2003 Excel 2007 Excel 2010
= On the toolbar, Select File | = Click the Microsoft Office | = Click the File tab
=
> Save As Button F = Select Save As
= |n the File name: field = Select Save As > Excel . )

. . 0 = |n the File name: field,
assign the working file a Macro-Enabled Workbook assign the working file a
new hame = |n the File name: field, new name

y select Excel Macro-
= Choose a location to store | = Choose a location to store Enabled Workbook
gaev\;vorklng file and click g:v\évorklng file and click = Choose a location to store
the working file and click
Save
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Enabling Macros

Certain functionality within the tool, such as the ability to clear an entire sheet using a button like
the one shown here, is driven by Excel macros, or a series of commands.

Clear Owner Goals

If macros are disabled in your software, follow the steps below to enable them. Note that
Microsoft recommends returning to a safer macro setting when not using macros.

Microsoft® Office

Excel 2003

Microsoft® Office
Excel 2007

Microsoft® Office
Excel 2010

= On the toolbar, select
Tools > Macro > Security

= Select “Low” and click OK

= Close and re-open the file
to ensure macros are
enabled

= Click the Microsoft Office
Button (73

= Click Excel Options

= Click Trust Center, then
Trust Center Settings

= Click Macro Settings

= Select Enable all macros
and click OK

= Close and re-open the file
to ensure macros are
enabled

= When you open the file, a
yellow Security Warning
Message Bar will appear

= On the Message Bair, click
Enable Content

= Close and re-open the file
to ensure macros are
enabled

Error Messages

Error messages and related explanations will appear when common or critical errors are made.
These are typically displayed within the face of the spreadsheet but may also appear in the

bottom taskbar.
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Spreadsheet Worksheets

The spreadsheet is divided into several color-coded worksheets. Each set of worksheets is
comprised of tools that work independently or interdependently to execute a specific analysis
per the table below.

Note that within each worksheet, all data should be entered in the yellow highlighted cells only.

After-Tax Cash Standalone
Flow Analysis Tools

Before-Tax Cash
Flow Analysis

— -

Comp Grids

Calculator

Effective Rent
After-Tax
Cash Flow Leverage Tool
Budget v Actual
Forecast

Standalone
DCF Anlaysis

12 Month
Operating
Budget

Pro Forma
Statement

Before-Tax
Cash Flow

Residential

Unprotecting a Worksheet

Remember to enter data in the yellow highlighted cells only. The other cells are formula-driven
and are protected so that the formulas are not inadvertently written over. To unprotect a
worksheet, follow the steps below.

Microsoft® Office Microsoft® Office Microsoft® Office

Excel 2003 Excel 2007 Excel 2010

= On the toolbar, select = Click on the Review tab = Click on the Review tab

Tools > Protection = Select Unprotect Sheet = Select Unprotect Sheet

= Select Unprotect Sheet...

= Enter the password: = Enter the password:
= Enter the password: iremfirst iremfirst
iremfirst - Click OK - Click OK
= Click OK

iED 3
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Using this Guide

This guide is divided into sections by spreadsheet functions. Throughout the guide, you will find
detailed steps for completing each of these various functions.

In addition, there are “Tips” boxes which provide additional details or best practices.

Enter the Analysis Begin Month as follows: for Year 1, enter 1; for Year 2, enter 13;

o
|: for Year 3, enter 25, etc. For an interest-only loan, enter 0.

Lastly, there are “Data Output” boxes with a laptop icon that display data that is automatically
populated based on your data entry.

Initial Equity will be displayed.
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BEFORE-TAX CASH FLOW ANALYSIS

These worksheets appear in blue and are interdependent. They complete a before-tax cash
flow analysis to measure the performance of a real estate asset.

Owner Goals

This worksheet is the primary data entry sheet for the before-tax cash flow analysis.

= Begin by entering information in the Site, For, and By fields.

D__ The Date field will automatically populate with today’s date. The information entered
— here will be copied to the rest of the Before-Tax Cash Flow Analysis worksheets.

In the Analysis Variables box, enter the following as applicable:
= Loan Amount
= Loan Interest Rate

= Loan Amortization Period

If there is a second loan on the property, enter the amount, rate, and amortization
& period for Loan 2 as well. The Analysis Begin Month | Loan 2 Begin field must be
— populated with a number greater than 1 for the loan to appear in the Midstream
Analysis box.

Loan Pre-paid Points, Balloon Term, or Penalty Fee

Analysis Begin Month

& Enter the Analysis Begin Month as follows: for Year 1, enter 1; for Year 2, enter 13;
- for Year 3, enter 25, etc. For an interest-only loan, enter 0.

Owner’s Required Return

Going-In Capitalization Rate
Cost of Sale

In the Initial Analysis box, enter the following as applicable:

= Purchase Price
= Acquisition Expenses
= Points, Fees

Initial Equity will be displayed.

iED 5
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If conducting a midstream analysis, enter the following in the Midstream Analysis box:

= Current Market Value

Current Market Value will be displayed. This figure is automatically calculated by
dividing the current NOI from the Pro Forma Statement worksheet by the Going-In

@ Cap Rate. This field can also be overwritten. To restore the formula, click the “Clear
Owner Goals” button.

= Capital Improvements

=  New Points, Fees

@ Cost of Sale, Current Loan Balance, Cash-Out Potential and Current Equity will be
displayed.

= In the Going-Out Capitalization Rate box, enter rates for Years 2-10

Several loan ratios will be displayed in this worksheet. Important data such as
@ Annual Debt Service (ADS), Loan to Value Ratio (LTV), Effective Interest Rate, Loan

Constant (k%), and leverage are shown.

12 Month Operating Budget

This worksheet allows you to build an annual operating budget by entering monthly income and
expense figures.

To calculate net operating income (NOI), follow the steps below.

= Enter monthly gross potential income (GPI), loss to lease, vacancy and collection loss,
miscellaneous income, and any expense reimbursements

= Enter monthly operating expenses

@ Operating expense category totals will be displayed based on data entered for the
line items in that category. In addition, total operating expenses will be displayed.

Several blank lines are available for you to customize the expenses listed.

TIP

@ GPI, Net Rent Revenue, EGI, total operating expenses, and NOI will be displayed
for a 10-year holding period.
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E Capital expenditures may be entered below the NOI line by using the Capital
- Expenditures box.
% Click the “Clear 12 Month Operating Budget” button to clear all data.

Pro Forma Statement
This worksheet has two components: historical data and pro forma data.

Historical data can £ |
be entered for the
past two years and

the current year Pro forma data can be
entered for Years 1-10

Historical Data
To calculate net operating income (NOI) from historical data, follow the steps below.

= Enter gross potential income (GPl), loss to lease, vacancy and collection loss,
miscellaneous income, and any expense reimbursements for 2 years ago, 1 year ago, and
last year

= Enter operating expenses for 2 years ago, 1 year ago, and last year

GPI, Net Rent Revenue, EGI, total operating expenses, and NOI will be displayed.

Pro Forma Data

To calculate and project net operating income (NOI) for pro forma data, follow the steps below.

= Enter Year 1 gross potential income (GPI), loss to lease, vacancy and collection loss,
miscellaneous income, and any expense reimbursements

iED 7
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@ Year 1 income and expense figures will be displayed based on data entered in the
12 Month Operating Budget worksheet. These cells can be overwritten.

= Enter Year 1 operating expenses

If only total income is known, enter total income in the GPI line. If only total
expenses are known, enter total expenses in any one of the expense lines. There
are several blank lines available in the expenses column.

TIP

= |n the Annual Increase column, enter the projected annual percent increase in income and
expenses

If actual annual figures are known and are not based on the annual percentage
increases, enter the figures directly in the appropriate cell, overwriting the existing
formula.

GPI, Net Rent Revenue, EGI, total operating expenses, and NOI will be displayed
for a 10-year holding period.

Capital expenditures may be entered below the NOI line by using the Capital
Expenditures box. Entering data here will adjust the before-tax cash flows on the
Before-Tax Cash Flow worksheet.

Click the “Clear Pro Forma Statement” button to clear all data.

TIP TIP m TIP
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Before-Tax Cash Flow

This worksheet is output-only and displays results based on data entered in the other Before-
Tax Cash Flow worksheets.

The Analysis Variables and Initial Analysis box restates information entered in
the Owner Goals worksheet.

The Before-Tax Cash Flow (BTCF) box displays before-tax cash flows projected for
ten years based on NOI, loan principal, loan interest, and any capital improvements
for each year.

The Proceeds of Sale Analysis box displays net sales proceeds by subtracting the
cost of sale and current loan balance from the sale price.

The 5 Year T-Bar is displayed for easy viewing of a five-year holding period. The T-
bars visually display equity, before-tax cash flows for each year, and the sales
proceeds.

The Tests of Investment Return box displays results of several tests of investment
return from Years 2-10: cash-on-cash rate of return ($/$%), value enhancement, net
present value (NPV), internal rate of return (IRR), and modified internal rate of return
(MIRR). The Year 5 data is highlighted.

At the end of the IREM® Financial Analysis Spreadsheet, three additional before-tax
display-only worksheets can be found. The BTCF T Bars worksheet displays equity,

cash flows, and net sales proceeds (NSP) for Years 2-10 of the analysis. The Loan 1
and Loan 2 Amortization worksheets display the loan amortization schedules based

on data entered in the Before-Tax Cash Flow worksheet.

R L2 [ [ [ [
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COMPARISON GRIDS

These worksheets appear in and function . They calculate average
adjusted effective rent for an office, residential, or retail property based on data entered
regarding comparable properties.

Office Comparison Grid

To calculate average adjusted effective rent per square foot, follow the steps below.

= Enter property names for the subject and comparable properties.

= Enter the base rental rate and any concessions, expense pass-throughs, and tenant-paid
improvements for each comparable property.

All figures are per annual rentable square foot.

= Evaluate the comparables against the subject property and assign each category a rating
such as: poor, fair, good, very good, or excellent.

There are open blank lines at the bottom of the Categories column to enter any
additional categories as needed.

= Enter adjustments for each category. If the comparable is rated superior to the subject
property, assign a negative number to adjust the comparable downward. If the comparable
is rated inferior to the subject property, assign a positive number to adjust the comparable
upward.

&/

Total rent adjustments and adjusted effective rent for the comparable properties will
be displayed. Average adjusted effective for the subject property will be displayed.

Click the “Clear Office Comparison Grid” button to clear all data.

10
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Residential Comparison Grid

To calculate average adjusted effective rent, follow the steps below.

= Enter property names for the subject and comparable properties.

= Enter the base rental rate and any concessions or other income for each comparable
property.

= Enter the square feet per unit for the subject and comparable properties.

= Evaluate the comparables against the subject property and assign each category a rating
such as: poor, fair, good, very good, or excellent.

There are open blank lines at the bottom of the Categories column to enter any
additional categories as needed.

= Enter adjustments for each category. If the comparable is rated superior to the subject
property, assign a negative number to adjust the comparable downward. If the comparable
is rated inferior to the subject property, assign a positive number to adjust the comparable
upward.

</

Total rent adjustments and adjusted effective rent per unit for the comparable
properties will be displayed. Average adjusted effective rent for the subject property
will be displayed.

Average adjusted effective rent is provided both per unit and per square foot.

Click the “Clear Residential Comparison Grid” button to clear all data.

iED ”
[
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Retail Comparison Grid
To calculate average adjusted effective rent, follow the steps below.
= Enter property names for the subject and comparable properties.

= Enter the base rental rate and any concessions, expense pass-throughs, and tenant-paid
improvements for each comparable property.

All figures are per annual rentable square foot.

= Evaluate the comparables against the subject property and assign each category a rating
such as: poor, fair, good, very good, or excellent.

There are open blank lines at the bottom of the Categories column to enter any
additional categories as needed.

= Enter adjustments for each category. If the comparable is rated superior to the subject
property, assign a negative number to adjust the comparable downward. If the comparable
is rated inferior to the subject property, assign a positive number to adjust the comparable
upward.

Total rent adjustments and adjusted effective rent for the comparable properties will
@ be displayed. Average adjusted effective rent for the subject property will be
displayed.

Click the “Clear Retail Comparison Grid” button to clear all data.

12
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AFTER-TAX CASH FLOW ANALYSIS

This worksheet appears in and functions . It completes an after-tax cash
flow analysis to measure the performance of a real estate asset taking into account variables
such as cost recovery, income tax, and capital gains tax.

After-Tax Cash Flow

To perform an after-tax cash flow analysis, follow the steps below.

In the Analysis Variables box, enter the following as applicable:
= Loan Amount (Loans 1, 2)

= Loan Interest Rate (Loans 1, 2)

= Loan Amortization Period (Loans 1, 2)

* Analysis Begin Month (Loans 1, 2)

= Owner’s Required Return

= Going-Out Capitalization Rate

= Cost of Sale

* |ncome Tax Rate

= Recapture Rate

= Capital Gains Rate

In the Initial Analysis box, enter the following as applicable:
= Purchase Price

= Acquisition Expenses

= Points, Fees

@ Initial Equity will be displayed.

If conducting a midstream analysis, enter the following in the Midstream Analysis box:
= Current Market Value

= Capital Improvements

= New Loans

= New Points, Fees

@ Cost of Sale, Current Loan Balance, Cash-Out Potential and Current Equity will be
displayed.

iED -
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In the Cost Recovery box, enter the following:

= Land Allocation

= Recovery Period

In the Cash Flow and Taxable Income box, enter the following:
= Year 1 NOI

Enter Year 1 NOI from the Pro Forma Statement worksheet if desired. If NOI
increases the same percent each year, enter the percentage increase in the NOI %
Increase box. Otherwise, manually enter the NOI for each year.

= Previous Suspended Losses

= Passive Losses Used

&/

After all data is entered, the Cash Flow and Taxable Income box displays figures
such as: loan principal and interest, before-tax cash flow (BTCF), cost recovery, tax
deductions, taxable income, and after-tax cash flow (ATCF) for the holding period.

The Proceeds of Sale Analysis box displays figures such as: cost recovery, basis,
total tax on sale, before-tax sales proceeds and after-tax net sales proceeds.

The final box displays results of the tests of investment return based on the after-tax
cash flows for the entire holding period, including cash-on-cash rate of return ($/$%),
value enhancement, net present value (NPV), internal rate of return (IRR), and
modified internal rate of return (MIRR).

At the end of the IREM® Financial Analysis Spreadsheet, three additional after-tax
display-only worksheets can be found. The ATCF T Bars worksheet displays equity,
cash flows, and net sales proceeds (NSP) for Years 2-10 of the analysis. The Loan 1
and Loan 2 Amortization worksheets display the loan amortization schedules based
on data entered in the After-Tax Cash Flow worksheet.

14
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STANDALONE TOOLS

These worksheets appear in purple and function independently. They complete a number of
functions, including:

= Emulating a financial calculator
= Calculating effective rent

= Assessing leverage position

= Forecasting budgets

= Conducting a discounted cash flow analysis

Calculator
The Calculator worksheet performs both basic math functions such as adding, subtracting,
multiplying, and dividing as well as more complex time value of money (TVM) calculations.
To perform a TVM calculation, follow the steps below.
= Enter the known variables into the appropriate field:

—  Number of Payments (N)

- Interest Rate (I/'YR)

- Present Value (PV)

- Payment (PMT)

- Future Value (FV)
= Select the number of payments per year (P/YR), typically 1 or 12

= Select Beginning or End mode

i The spreadsheet defaults to End mode as most calculations are done using this

- mode.

= Click the function button to solve for the missing variable.

The missing TVM variable will be displayed.

Click the “Clear All” button to clear all data.

i [
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Effective Rent

The effective rent tool calculates both the net present value and effective net rent of lease deals.
Effective net rent is expressed in dollars per square foot per year.

When analyzing rental streams from a landlord perspective, all number values
should be input as positive numbers, regardless of whether they are inflows or
outflows.

H

To calculate effective rent with no concessions, follow the steps below.

= Enter the Rentable Square Feet and Lease Terms (Begin and End dates)

The tool will accommodate an analysis up to 15 years (180 months). The ending
date entered must be later than the beginning date. The lease term will be calculated
and rounded to the nearest number of months.

TIP

= Complete the Base Rent Schedule with End Month and $/Rentable Sq. Ft./Yr. for all months
in the Lease Term. Enter periods of free rent with $0 (not blank).

The Start Month will be displayed based on the End Month entered. When the entire
term has been entered, the next row will not impact the calculation, as long as
neither an ending month nor rent > $0 is input.

[]

= Enter the Annual Discount Rate for Analysis as an annual figure.

Net present value and effective net rent of the lease terms will be displayed.

[]

To calculate effective rent with concessions:
= Follow the steps above.
= Enter landlord concessions in whole dollars (not dollars per square foot).

= |nput the timing of the payment of each concession (the month each will be paid).

If the lease requires the tenant to repay the cost of a particular concession:

-  Enter "1" in Column E; otherwise leave as default value of “0”.

- If repayment will be in a lump sum, enter "1" in Column F; otherwise enter the number of
months over which the repayment will be made in Column F.

- If the concession repayment includes interest, input the Annual Amortization Rate for
Concessions as an annual figure in the box provided.

16
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The concession amortization period will start the month following when the

Amortization per Month will be displayed. This is the monthly payment required to
pay back the concession amount over the amortization period, including interest.
concession is paid. The amortization period must be shorter than the Lease Term.

If the tenant will pay back part of the cost of particular concession, split the
recoverable and non-recoverable portions on separate lines. If the landlord is taking
over payments on a tenant's existing lease and will be making the payments over
the remaining existing lease term, calculate the present value of the expected
payments over the term using the same discount rate as this analysis, then enter the
PV in Column C and "1" in Column D.

TIP

Net present value and effective net rent of the lease terms will be displayed.

@

To calculate effective rent when the landlord has a financial exposure to expenses
through the base year or to expense stop lease structures:

Follow the steps above.

Enter a Beginning Opex and/or Beginning Tax value in dollars per rentable square foot per
year. This figure should reflect estimated expenses and/or taxes during the first year of the
analysis.

Enter a percentage value in Est. Opex Growth Rate and/or Est. Tax Growth Rate. This will
inflate the respective estimated expense each year of the analysis.

Enter a Landlord Opex Stop and/or Landlord Tax Stop figure. This represents the level of
expenses and/or taxes per square foot up to which the landlord is responsible for paying.
The tool will offset expenses above this level with tenant contributions.

For full service leases, enter an amount that is greater than the inflated estimated
expenses at the end of the lease term (e.g., $99.99).

Net present value and effective net rent of the lease terms will be displayed.

Click the “Reset all input fields” button to clear all data. Click the “Reset rental
stream” button to clear the Base Rent Schedule only. If only a few variables are
changing, consider over-writing them instead of clearing all values.

TIP m TIP

iED !
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Leverage Tool

The leverage tool computes several lender ratios based on loan terms entered in the worksheet.
To calculate lender ratios including loan-to-value ratio (LTV), debt coverage ratio (DCR), loan
constant (k%), and free-and-clear rate of return, enter the following loan terms as applicable:
=  Amount

* |Interest rate

=  Amortization period

*  Pre-paid points

= Balloon term

= Pre-payment penalty

= Purchase price or value

= NOI

Lender ratios will be displayed. Note that some data outputs (LTV, DCR) are
@ dependent on the loan amount entered and some (k%, Free-and-Clear Rate of

Return) are not.

18
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Budget v Actual Forecast Tool

The budget forecasting tool provides an operating budget template in which income and
expense line items can be entered and forecasted.

% This tool utilizes straight averages to forecast figures.

To forecast income, expenses, and NOI, follow the steps below.
= Enter the number of months in the Actual Y-T-D column

= Enter budget and actual figures for gross potential income (GPI), loss to lease, vacancy and
collection loss, miscellaneous income, and expense reimbursements

= Enter budget and actual figures for all operating expenses

Forecasted figures will be displayed.

Click the “Clear Forecast Tool” button to clear all data.

TIP

iED ;
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Standalone DCF Analysis

The standalone discounted cash flow (DCF) analysis tool calculates net present value (NPV)
and internal rate of return (IRR) for a property given income stream and required return rate.

Holding period can range from three to ten years.

TIP

To calculate NPV and IRR, follow the steps below.
= Enter the owner’s required rate of return

= Enter the current equity in Year 0

= Enter cash flows for up to ten years

= Enter net sales proceeds (NSP) in the last year of the holding period

@ NPV, IRR, and the price to pay in order to achieve the owner’s desired discount rate
will be displayed.

TIP

There is one “Clear DCF Analysis” button for each T-bar.

20





